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COURSE OBJECTIVES 

By the end of this course you will be able to 

 Briefly describe the benefits of a relational database. 

 Correctly, create an Access database, without reference to notes. 

 Briefly describe the use of a primary key. 

 Accurately create database tables in design view, without reference to notes. 

 Briefly describe the difference between a one-to-one and a one-to-many relationship. 

 Establish and edit relationships within a database, referring to notes if necessary. 

 Create and modify a simple query using specified criteria, referring to notes if necessary. 

 Accurately create a calculated field in query, referring to notes if necessary. 

 Create a summary query using specified criteria, referring to notes if necessary. 

 Create a simple report using the Report Wizard, without reference to notes. 
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MODULE 1 – DATABASES AND TABLES 

OBJECTIVES 

At the end of this section you will be able to: 

 Briefly describe the benefits of a relational database. 

 Correctly, create an Access database, without reference to notes. 

 Briefly describe the use of a primary key. 

 Accurately create database tables in design view, without reference to notes. 

WHAT IS A DATABASE? 

A database is a store of information held in a structured way, to make it quick and convenient to 

access the information. 

Microsoft Access is a relational database. A relational database holds its data in tables. These tables 

may be linked together, using common values within them. The tables are not permanently linked 

together. Each table is an independent data store - but the database system is capable of linking the 

data together - when required. 

Generally speaking, each table contains data relating to a particular subject, for example, customer 

details could be held in one table, and the orders placed by the customers in a separate table. If you 

wished to see all the orders for a particular customer, the tables could be linked. See Appendix A for 

more detail on page 33. 

DATABASE TERMINOLOGY 

Tables 

Databases are made up of one or more 

tables. Tables are the building blocks of 

relational databases. Each table usually 

contains all the information associated 

with a particular subject, for example, 

customer details, product details, or 

personnel information. A table is made 

up of records, or rows, each containing 

a number of fields, or columns. 

Records 

Each record in a table contains 

information about a single item in the 

table - for instance a person, an invoice, 

or a product. Think of a record as a card in a library index. 

Fields 

Each field within a record is a category of information - for instance the surname, street or telephone 

number of a member of staff; the invoice number or invoice date of an invoice. 
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Data Types 

This term describes the type of data that is entered into a field. Each field has the same data type for 

each record in the database file - although the actual data will probably be different. There are many 

different data types, which we will look at in detail later. 

Table Relationships 

Tables that can be linked together are said to have a relationship. Linking tables allows you to extract 

related information from more than one table at the same time. This information could be displayed on 

the screen, or make up a printed report. 

Primary Keys 

Primary keys uniquely identify a record in its table. For instance each person has his or her own 

unique National Insurance number. This would serve as a useful primary key for a typical staff 

database. This primary key can then be used to link data from its record to other tables. 

THE COURSE DATABASE 

This course uses a database based on the Northwind Traders database. This database contains 

information about a fictitious import/export company called Northwind Traders, which specialises in 

gourmet food from around the world. The tables used in the database file are: 

CUSTOMERS Details of companies who order products from the company. 

EMPLOYEES  Details of the sales people working for the company. 

ORDERS  Orders placed by the customers. Includes details of where the products are to 

be shipped to, but no information about the individual items on each order. 

ORDER DETAILS  Details of the items on each order such as price, quantity ordered. 

PRODUCTS  A list of the products, describing each, plus information about stock levels. 

CATEGORIES  A description of the categories that the foods have been divided into.  

THE RIBBON 

The Ribbon is designed to help you quickly find the commands that you need to complete a task. 

Commands are organized in logical groups, which are collected together under tabs. Each tab relates 

to a type of activity, such as writing or laying out a page. To reduce clutter, some tabs are shown only 

when needed. There Ribbon can be customised by end-users.  

Some groups have additional Dialog Box Launchers which are found at the right-hand end of the 

Group title bar. Click on one of these to launch a more detailed dialog to have extra control in relation 

to that group’s subject. For example the dialog box launcher in the Clipboard group displays the 

Office Clipboard.   

To always keep the Ribbon minimized 

1. Click on the Customize Quick Access Toolbar button.  

2. In the list, click on the Minimize the Ribbon option.  

3. To use the Ribbon while it is minimized, click on the tab you 

want to use, and then click the option or command you want 

to use. 
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To keep the Ribbon minimized for a short time 

 To quickly minimize the Ribbon, double-click the name of the active tab. Double-click any tab 

again to restore the Ribbon.  

To restore the Ribbon 

1. Click on the Customize Quick Access Toolbar button. 

2. In the list, click on the Minimize the Ribbon option 

Customising the Quick Access Toolbar 

The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are 

independent of the tab that is currently displayed. The Quick Access Toolbar can be located in one of 

two places - either above or below the Ribbon. You can add a command to the Quick Access Toolbar 

directly from commands that are displayed on the Ribbon. 

To move the Quick Access Toolbar 

1 Click on the Customize Quick Access Toolbar button. 

2 In the list, click on Show Below the Ribbon or Show Above the Ribbon as required. 

To add a command to the Quick Access Toolbar 

1. Click on the Customize Quick Access Toolbar button. 

2. On the Ribbon, click on the appropriate tab or group to display the command that you 

want to add to the Quick Access Toolbar.  

3. Right-click on the required command, and select Add to Quick Access Toolbar.  

Notes: You cannot increase the size of the buttons. The only way to increase the size of the buttons 

is to lower the screen resolution you use.  You cannot display the Quick Access Toolbar on 

multiple lines. Only commands can be added to the Quick Access Toolbar.  

The Ribbon is customizable also. This however, is not covered on this course. 
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THE ACCESS SCREEN LAYOUT 

The Ribbon has many tabs. The one shown initially is the Home tab.  Additional tabs will appear 

automatically when specific actions or objects are selected.  

Status Bar 

The status bar can be customised to display or hide various items. Right-click on the status bar and 

select/de-select the appropriate items. 

Getting Help 

Access provides on-line, context-sensitive help. Press 1 at any time to obtain help relevant to the 

particular operation. It is also possible to access Help by clicking on the Help icon in the top-right 

hand corner of the Access window. 

Wizards 

When creating new objects such as a query, form or report, Access gives you the choice of creating the 

object from a blank design, or using a Wizard to help you. The Wizard is like having a database expert 

on hand to help you. It prompts you with questions concerning the design of an object and generates 

that object based on your answers. 

There are many different Wizards available to help with various tasks within Access. 

BACKSTAGE VIEW 

The Ribbon contains the set of commands for working in a database, while the Office Backstage view 

is the set of commands you use to do things to a database. 

Open a database, and click on the File tab to see the Backstage view. The Backstage view is where 

you manage your databases and related data about them - create, save, encrypt and publish databases, 

set options, and more.  

   Ribbon          Help 
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To open backstage view 

Click on the File tab. 

To close backstage view and return to your document 

Either click on the any Ribbon tab, or press E on your keyboard. 

OPENING A DATABASE 

A Microsoft Access database is made up of a collection of objects. A single database file can contain 

tables, queries, forms, reports, pages, macros and programming modules (the latter two types of object 

will only be seen and listed in the Navigation Pane after they have been created and saved). Together 

these objects help you to work with your data to the best effect. 

Only one database can be opened at any given time, although within a database many tables may be 

open simultaneously. 

To open a database  

1. Click on the File tab, then select Open. 

2. If the database has been opened recently, its name could be shown in the Recent list. 

Otherwise, click on the Computer option. Access will display different folder options, 

including a list a recent folders. Select an appropriate option, navigating to another 

folder if necessary. 

Note: If you have a OneDrive subscription then you can connect to OneDrive to work 

with files stored in the cloud. Access will create a local copy and then synchronise the 

changes with the cloud copy. 

3. Choose the required file in the Open dialog. 

4. If you have not modified any security settings you might receive a warning similar to 

this shown here. 

 

5. If you are confident the 

database contains no 

harmful code, click on 

Enable Content  

 Note: You can point and 

click on Some active content… and then choose different enabling options using the 

backstage view shown here. 

6. If the file has been opened from a 

network location, you will be 

prompted to make the file a Trusted 

Document. If you click on Yes you 

will not be prompted to enable 

content on future opening of the file. 

If you tick the Do not ask me again 

for network files box you will not be prompted to enable content for any further files on 

the network. This is a major reduction in security settings and is not normally 

recommended. 
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EXERCISE 1  

1. Open the Traders database.  

2. In the database, create a new table in design view with the following field names and data 

types: 

 

Field name Data Type 

EventId AutoNumber 

EventName Text 

StartDate Date/Time 

EndDate Date/Time 

Fee Currency 

 

 Set the EventId field as the Primary Key of the table. 

 Save the table with the name Events and close it down. 

3. Open the Events table in Design View again and modify the following field properties: 

 

Field Name Field Size Format Caption Indexed Required 

EventName 40 Upper case Event Name  Yes 

StartDate  Medium date Start Date Yes (duplicates OK)  

EndDate  Medium date

  

End Date   

 

4. Again in Design View add the following multi-value field to the Events table; make sure you 

include the EmployeeID, LastName and FirstName fields when using the wizard. Have the names 

sorted in Ascending last Name order. 

  

Lookup from the Employees table 

Field name Data Type Description 

Employees Multi-Value Field Staff members attending this event 

 

5. Open the Events table in datasheet view. Add the following records: 

 

EventID EventName StartDate EndDate Employees 

1 Shrewsbury Flower Show 02/08/2013 04/08/2013 Davolio, Page 

2 Chelsea Flower Show 11/06/2013 14/06/2013 Buchanan, Callahan 
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EXERCISE 2  

1. From the Traders database, ensure all the following tables appear in the relationship window: 

Customers  Employees   Events 

Orders   Categories 

Order Details  Products 

 

2. Set relationships between the following tables, enforcing referential integrity each time: 

 

Primary Table Related table Field to relate on 

Customers Orders CustomerId 

Orders Order Details OrderId 

Products Order Details ProductId 

Categories Products CategoryId 

Employees Orders EmployeeId 

 

Note: You haven’t set up a relationship between Employees and Events as this is managed by 

Access behind the scenes resulting from the multi-value field that was set up in Exercise 1. 

 

3. Open the Products table. Add in a new product - your favourite drink. Use CategoryId 1 

(beverages). 

 

4. Try adding another product using CategoryId 10. What happens when you try to move to 

another record? Change the CategoryId to 1. 

 

5. Close the Products table and open the Categories table. 

Try to delete Category 4. What happens? 
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